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[Abstract] Paper nanobiosensors have been established as an excellent platform for analysis of 

veterinary and human pathogens causing various diseases. Especially, lateral flow assays or biosensors 

ideal for sensitive, rapid, robust and accurate analysis in laboratory setups and on-site analysis. Viral 

RNA detection is of great importance for public health as well as animal health protection. In that aspect, 

the present protocol focuses on the development of functionalized gold nanoparticle-based lateral flow 
biosensor for fish nervous necrosis virus (Nodavirus) nucleic acids detection. Total viral RNA, isolated 

from fish samples was subjected to reverse transcription PCR amplification and the amplification 

products were mixed with specific oligonucleotide probe. A red test line was formed when nodavirus 

product was present. The proposed assay has great implications on basic research since it eliminates 

the need for time-consuming, cumbersome electrophoresis protocols and could be adjusted for use on 

the site of fish culture by fish farmers. Disease monitoring by such bioanalytical platforms without time 

consuming and costly procedures would have great impact on the aquaculture and environmental safety. 
Keywords: Lateral flow biosensor, Lateral flow assay, Immunochromatographic assay, Gold 

nanoparticles, Nervous necrosis virus, Nodavirus 

 

[Background] Point-of-care and/or on-site bioanalysis has been the ultimate goal of research efforts 

focusing on the well being of humans and animals. Sensing platforms based on paper substrates are 

very attractive as analytical platforms because they are functionalized easily, with great reproducibility 

and low fabrication costs. Paper-based analytical devices have been applied on the analysis of small 

molecules, proteins and all kinds of nucleic acids (Parolo and Merkoçi, 2013; Bahadir and Sezgintürk, 
2016; Jiang et al., 2019). Lateral flow biosensors (LFBs) are prefabricated strips of materials with dry 

reagents and they are activated by fluid samples. They are designed for disposable single use where 

an on/off signal is sufficient (Posthuma-Trumpie et al., 2009). Lateral flow nanobiosensors incorporate 

nanoparticles and are optimal for rapid analysis in research laboratories, along with their potential for 

use on point-of-care. Gold nanoparticles, with size smaller than 100 nm, are mainly used as LFB labels 

due to their unique optical properties, i.e., vivid red color, easy surface functionalization with a variety of 

biomolecules, intense optical signal, high surface-to-volume ratio and exceptional chemical stability 

(Cheng et al., 2019; Posthuma-Trumpie et al., 2009). 
  In that frame, our research efforts are focused on the development of gold nanoparticle-based lateral 

flow biosensors for virus assessment. The present protocol was developed for fish nervous necrosis 

virus or nodavirus nucleic acids detection (Toubanaki et al., 2015), in order to increase the detection 

accuracy, simplify and speed up the total time of PCR-based analysis. In brief, total viral RNA, isolated 
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from fish samples was subjected to reverse transcription PCR (RT-PCR) amplification. The PCR 

products were mixed with specific oligonucleotide probe and applied next to oligonucleotide conjugated 

gold nanoparticles (Au NPs). A red test line was formed when nodavirus product was present. The visual 

detection of the RT-PCR product was completed within 20 min. The present detection platform has been 
utilized in other pathogens detection (e.g., hepatitis C virus [Glynou et al., 2003]; bacterial infections 

[Kalogianni et al., 2007]; Leishmania parasite DNA [Toubanaki et al., 2016]) and could be adjusted for 

other pathogens detection with proper primers and probe design. 

 

Materials and Reagents 
 

A. Materials 

1. 0.22 μm filter 
2. Pipettes tips: 0.5-10 μl, 10-200 μl (Greiner Bio-One, catalog numbers: 771291, 739290) 

3. Filtered tip racks 0.5-10 μl, 5-100 μl, 5-200 μl and tip racks 0.5-20 μl, 2-200 μl, 50-1,000 μl 

(Brand, catalog numbers: 732624, 732630, 732632, 732124, 732128, 732132) 

4. Siliconized tubes 1.7 ml (Sigma-Aldrich, catalog number: T3406) 

5. Stainless steel beads 5 mm (Qiagen, catalog number: 69989) 

6. 1.5 ml polypropylene tubes, attached flat-cap (Greiner Bio-One, catalog number: 616201) 

7. 15 ml polypropylene tubes, screw cap (Greiner Bio-One, catalog number: 188271) 
8. 50 ml polypropylene tubes, screw cap (Greiner Bio-One, catalog number: 227261) 

9. Glass fiber pad (Millipore, catalog number: GFCP000800), store at RT 

 

B. Reagents 

1. Agarose (HT Biotechnology, catalog number: SB11a), store at RT  

2. β-Mercaptoethanol (β-ME) (Sigma-Aldrich, catalog number: 444203), store at RT 

3. Cellulose fiber pad (Millipore, catalog number: CFSPOO1700), store at RT 

4. Dextran cross-linked G-25 (Sigma-Aldrich, catalog number: 92639), store at RT 
5. dNTPs: dATP, dTTP, dCTP, dGTP (HT Biotechnology, catalog number: SB23), store at -20 °C 

6. Ethanol absolute (Sigma-Aldrich, catalog number: 32205-M), store at RT 

7. Ethidium bromide (Sigma-Aldrich, catalog number: E1510), store at RT 

8. Glycerol (Applichem, catalog number: A2926,1000), store at RT 

9. Gold nanoparticles 40 nm (Sigma-Aldrich, catalog number: 741981), store at 4 °C 

10. GoTaq Flexi DNA polymerase (Promega, catalog number: M8301), store at -20 °C 

11. Hydrochloric acid (HCl) solution, 1 M (Sigma-Aldrich, catalog number: 150696), store at RT 

12. Methanol (Sigma-Aldrich, catalog number: 322415), store at RT 
13. Nitrocellulose membrane (Millipore, catalog number: HF180MC100), store at RT 

14. N-methylmaleimide (Sigma-Aldrich, catalog number: 389412), store at RT 

15. Oligonucleotides (Table 1): dA20, SH-dT30, UpNdv_B upstream primer, DpNdv downstream 

primer, probe_Ndv (VBC-Biotech, custom order), store at -20 °C after reconstitution 
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Table 1. Oligonucleotides used in the present protocol 

Oligonucleotide Sequence (5′ → 3′) Modification 

dA20 AAAAAAAAAAAAAAAAAAAA − 

SH-dT30 SH-

TTTTTTTTTTTTTTTTTTTTTTTTTTTTTT 

5′ Thiol group 

UpNdv_B upstream primer B- AAGAAATTGGCAAAACCCG 5′ Biotin 

DpNdv downstream primer TATCCGTCTGTTCCTGTCCC − 

probe_Ndv CCTTAGACACAGGTGCGTCA − 

 

16. PCR-grade water (Jena Bioscience, catalog number: PCR-258-500), store at 4 °C 

17. Pyridine (Sigma-Aldrich, catalog number: 270970), store at RT 

18. RNaseOUTTM Recombinant Ribonuclease Inhibitor (Invitrogen, catalog number: 10777019), 

store at -20 °C 

19. RNeasy Mini kit (Qiagen, catalog number: 74104), store at RT 
20. Sodium chloride (NaCl) (Applichem, catalog number: 381659), store at RT 

21. Sodium Dodecyl Sulfate (SDS) (Sigma-Aldrich, catalog number: L4509), store at RT 

22. Sodium hydroxide (NaOH) solution, 1 M (Sigma-Aldrich, catalog number: 79724), store at RT 

23. Streptavidin from Streptomyces avidinii (Sigma-Aldrich, catalog number: S4762), store at -20 °C 

24. Sucrose (Sigma-Aldrich, catalog number: S0389), store at RT 

25. SuperScript II (Invitrogen, catalog number: 18064014), store at -20 °C 

26. Terminal deoxynucleotidyl transferase (New England Biolabs, catalog number: M0315S), store 

at -20 °C 
27. Tween-20 (Sigma-Aldrich, catalog number: P9416), store at RT 

28. φX174 DNA HaeIII digest DNA (New England Biolabs, catalog number: N3026 S), store at -

20 °C 

29. Potassium chloride (KCl) (Sigma-Aldrich, catalog number: 746336), store at RT 

30. Sodium phosphate dibasic (Na2HPO4) (Sigma-Aldrich, catalog number: 795410), store at RT 

31. Potassium phosphate monobasic (KH2PO4) (Sigma-Aldrich, catalog number: 795488), store at 

RT 
32. Phosphate-buffered saline, 10× (PBS, pH 7.4) (see Recipes) 

33. LFB developing solution (see Recipes) 

 

Equipment 
 

1. -20 °C freezer 

2. -80 °C freezer 

3. Desktop scanner (HP, HP Scanjet G4050) 
4. Dosage syringe 100 µl for Linomat (Camag, catalog number: 695.0014) 

5. Microcentrifuge (Heraeus, Sepatech) 
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6. Paper cutter Guillotine (Plaisio Office Supplies, catalog number: 800882) 

7. Sonicator bath Bransonic (Sigma-Aldrich, catalog number: Z305359EU) 

8. PCR Workstation (Euroclone-Bioair, Aura) 

9. pH Meter (Thermo Fisher Scientific, catalog number: 13-644-928) 
10. Pipettes: 

Nichipet EXII 0.5-10 μl and 20-200 μl (Nichiryo, catalog numbers: NPX-10, NPX-200) 

Transferpette S 0.5-10 μl, 10-100 μl, 20-200 μl and 100-1,000 μl (Brand, catalog numbers: 

705870, 705874, 705878, 705880) 

11. Scissors and forceps, kept sterile with 70% ethanol 

12. Spectrophotometer (Thermo Fisher Scientific, model: NanoDropTM 1000, catalog number: ND-

1000) 

13. Thermal cycler (Applied Biosystems, GeneAmp PCR System 9700) 
14. Tissue homogenizer (TissueLyser LT) (Qiagen, catalog number: 85600) 

15. Tissue homogenizer adapter (TissueLyser LT Adapter 12-Tube) (Qiagen, catalog number: 69980) 

16. TLC applicator (Camag, Linomat, catalog number: 022.7808) 

17. Vortex (Velp Scientifica, mdoel: Vortex ZX3) 

18. Water bath (LabTech, model: LSB-015S) 

19. Water distiller (Sartorius, model: Arium® Comfort I, catalog number: H2O-I-1-UV-T) 

 
Software 
 

1. Adobe PhotoShop (Adobe Systems) 

2. CAMAG® HPTLC Software visionCATS Basic Version (Camag, catalog number: 028.0000) 

3. NanoDrop 1000 software (Thermo Fisher Scientific, NanoDrop ND-1000) 

4. ImageJ software (National Institutes of Health (NIH), https://imagej.net/Welcome) 

5. Microsoft® Office Excel 2010 (Microsoft) 

 
Procedure 
 

A. Tailing of dA20 oligonucleotide probes with dATP 

1. Dissolve the lyophilized oligonucleotide dA20 with the amount of PCR-grade water which is 

required to have 100 pmol/µl stock solution of the oligonucleotides, according to the 

manufacturer instructions. 

2. Set up the tailing reaction (20 µl) by mixing 2 µl of the terminal transferase reaction buffer, 

containing potassium acetate (50 mM), Tris-acetate (20 mM) and magnesium acetate (10 mM), 
in pH 7.9, 2 µl of CoCl2 (0.25 mM); 0.7 µl of dATP (3.5 mM), 0.5 µl of terminal deoxynucleotidyl 

transferase (TdT, 10 units) and 7 µl of dA20. 

3. Incubate for 1 h at 37 °C. 

4. Stop the reaction with incubation at 70 °C for 10 min. 
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5. Store the poly(dA) tailed oligonucleotides at -20 °C. 

 

B. Preparation of the dry-reagent lateral flow biosensors 

1. Wash the TLC applicator syringe: 
a. Wash 10 times with distilled-deionized water (ddH2O). 

b. Wash 10 times with 50% ethanol (EtOH). 

c. Leave filled until use. 

d. Wash 20 times with distilled-deionized water (ddH2O). 

2. Prepare the poly(dA) oligonucleotide working solution by diluting the 35 pmol/µl poly(dA) tailed 

stock with the appropriate volume of a solution containing 50 ml/L methanol and 20 g/L sucrose 

in 1× PBS buffer, to a final concentration of 4 pmol/µl. 

3. Prepare the streptavidin (SA) working solution by diluting a 10 µg/µl SA stock solution with the 
appropriate volume of a solution containing 150 ml/L methanol and 20 g/L sucrose in 1× PBS 

buffer, to a final concentration of 4 µg/µl. 

4. Load 7 µl of the 4 pmol/µl poly(dA) tailed working solution to the syringe. 

5. Spray the poly(dA) tailed working solution to the immobilized membrane in the TLC applicator 

instrument with velocity of 60 nl/s, to result in the control zone (CZ) of 2.4 pmol poly(dA) per 

4mm LFB. 

6. Spray the SA working solution to the immobilized membrane in the TLC applicator instrument 
with velocity of 250 nl/s, to result in the test zone (TZ) of 1.6 µg SA per 4 mm LFB. 

7. Dry the membrane at 80 °C for 1 h. 

8. Store the membrane at ambient temperature overnight. 

9. After each use wash the TLC applicator syringe as follows: 

a. Wash 5 times with NaOH 0.1 M. 

b. Leave the syringe filled for 15 min. 

c. Wash 20 times with ddH2O. 

d. Wash 5 times with HCl 0.1 M. 
e. Leave the syringe filled for 15 min. 

f. Wash 20 times with ddH2O. 

10. Assemble the LFB on a plastic adhesive backing (laminated card) as follows (Figure 1): 

a. First place the diagnostic membrane on the center of the laminated card. 

b. Then place the conjugate pad below the membrane, overlapping by 2 mm. 

c. Place the immersion pad below the conjugate pad, overlapping by 2 mm. 

d. Place the absorbent pad above the membrane, overlapping by 2 mm. 

11. Cut the LFBs to a 4mm with by the paper cutter. 
12. Store the LFBs at ambient temperature in the dark. 

 

Please cite this article as: Toubanaki and Karagouni, (2020). Paper Lateral Flow Biosensor for Nodavirus Reverse Transcribed RNA
Detection,Bio-protocol 10 (15): e3711. DOI: 10.21769/BioProtoc.3711.

http://www.bio-protocol.org/e3711


                 

Copyright © 2020 The Authors; exclusive licensee Bio-protocol LLC.  6 

www.bio-protocol.org/e3711     
Bio-protocol 10(15): e3711. 
DOI:10.21769/BioProtoc.3711

 
 

 
Figure 1. Schematic depiction of the lateral flow biosensor preparation procedure and side-
view of the LFB assembling parts on a plastic backing 

 

C. Tailing of SH-dT30 with dTTP 

1. Dissolve the lyophilized oligonucleotides (SH-dT30) with PCR-grade water in order to have an 

100 pmol/µl stock solution of the oligonucleotides. 
2. Set up the tailing reaction (20 µl) by mixing 2 µl of the terminal transferase reaction buffer (see 

A2), in pH 7.9; 2 µl of CoCl2 (0.25 mM); 0.7 µl of dTTP (3.5 mM); 0.5 µl of TdT (10 units) and 7 

µl of SH-dT30. 

3. Incubate for 1 h at 37 °C. 

4. Stop the reaction with incubation at 70 °C for 10 min. 

5. Store the SH-poly(dT) tailed oligonucleotides at -20 °C. 

 

D. Gel Permeation Chromatography (GPC) for tailed SH-poly(dT) purification 
1. Preparation of dextran cross-linked G-25. 

a. Put 5 g of dextran particles in a glass bottle. 

b. Add ddH2O until all particles are covered, even after they are swallowed. 

c. Incubate overnight at 4 °C. 

2. Pour the pre-treated dextran G-25 in the GPC column. 

3. Centrifuge at 750 × g for 6 min. 

4. Put the tailed SH-poly(dT) oligonucleotides in the center of the column by a pipett tip. 
5. Centrifuge at 750 × g for 2 min. 

6. Collect the flowthrough (~50 µl) in a 1.5 ml tube. 

7. Store the purified tailed SH-poly(dT) oligonucleotides at -20 °C. 
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E. Preparation of oligonucleotide conjugated gold nanoparticles 

1. Put 1 ml of gold nanoparticles (Au NPs: 40 nm, 7.2 × 1010 particles) in siliconized tubes. 

2. Add 75 pmol of purified tailed SH-poly(dT) oligonucleotides (10 µl) and 0.8 ml of absolute 

pyridine. 
3. Incubate at 4 °C, for 24 h, in the dark.  

4. Subsequently, add 16.7 µl of 900 mM NaCl solution and incubate at 4 °C, for 2 h, in the dark. 

5. Repeat step E.4 for 6 times, up to a final concentration of 90 mM (“salt aging” protocol). 

6. Incubate at 4 °C, for 24 h, in the dark.  

7. Centrifuge at 1,300 × g for 30 min. 

8. Discard the supernatant carefully. 

9. Resuspend the Au NPs pellet in 100 µl of an aqueous solution containing 30% sucrose, 0.25% 

Tween-20, 0.25% sodium dodecyl sulfate (SDS), and 45 mM NaCl, by vortexing and brief 
sonication (5 min). 

10. Store the poly(dT) conjugated gold nanoparticles at 4 °C, in the dark. 

 

F. Fish brain dissection 

1. Put the fish onto a dissecting mat and carefully break the skull open with scissors and forceps. 

2. Dissect the whole brain and remove it carefully with the forceps. 

3. Transfer the samples in sterile polypropylene tubes and store at -80 °C, until use. 
Note:  Naturally infected European sea bass (Dicentrarchus (D.) labrax) with or without VNN clinical 

signs were collected and euthanized from sea-cage fish farms. 

 

G. Total RNA extraction 

1. Remove the excised fish tissue from storage and thaw it in ice. 

2. Weigh an empty sterile 1.5 ml tube and add the tissue. Determine its weight and cut 30 mg of 

tissue with sterile scissor. If the isolated brain is bigger than 30 mg, the remaining tissue can 

be stored at -80 °C for future use. 
3. Add 6 µl of β-mercaptoethanol (β-ME) to 600 µl of Buffer RLT before use. 

Note: Dispense β-ME in a fume hood and wear appropriate protective clothing. 

4. Place the tissue in a sterile 1.5 ml tube and add ~600 µl Buffer RLT with β-ME. 

5. Add one stainless steel bead (5 mm) to the tube and put it in the TissueLyser Adapter. 

6. Disrupt the tissue and homogenize the lysate on the TissueLyser LT for 5 min at 50 Hz. 

Notes: 

a. Do not exceed this time as it may result in nucleic acid shearing. 

b. The TissueLyser Adapter is used directly after storage at -20 °C and the tissue disruption is 

performed at RT. Therefore, due to the short disruption time the adapter temperature 

remains low throughout the procedure. 

7. Centrifuge the homogenized sample for 5 min at full speed to ensure that all the tissue debris 

is on the bottom of the tube. 

Please cite this article as: Toubanaki and Karagouni, (2020). Paper Lateral Flow Biosensor for Nodavirus Reverse Transcribed RNA
Detection,Bio-protocol 10 (15): e3711. DOI: 10.21769/BioProtoc.3711.

http://www.bio-protocol.org/e3711


                 

Copyright © 2020 The Authors; exclusive licensee Bio-protocol LLC.  8 

www.bio-protocol.org/e3711     
Bio-protocol 10(15): e3711. 
DOI:10.21769/BioProtoc.3711

 
 

8. Carefully remove the supernatant by pipetting, and transfer it to a new 1.5 ml tube. 

9. Add 1 volume of 70% ethanol (stored at RT) to the cleared lysate, and mix by pipetting. Do not 

centrifuge. 

Note: Precipitates may be visible after addition of ethanol. 

10. Transfer 700 μl of the sample, including any precipitate that may have formed, to an RNeasy 

spin column placed in a 2 ml collection tube. 

11. Centrifuge for 30 s at 10,000 × g. Discard the flow-through. 

12. Repeat Steps G10 and G11 with the remaining sample. 

13. Add 700 μl Buffer RW1 to the RNeasy spin column to wash the spin column membrane. 

14. Centrifuge for 30 s at 10,000 × g. Discard the flow-through. 

15. Add 500 μl Buffer RPE to the RNeasy spin column to wash the spin column membrane. 

16. Centrifuge for 2 min at 10,000 × g. Discard the flow-through. 
17. Place the RNeasy spin column in a new 2 ml collection tube. 

18. Centrifuge at full speed for 1 min. 

19. Place the RNeasy spin column in a new 1.5 ml collection tube and add 30 μl RNase-free water 

directly to the spin column membrane. 

20. Centrifuge for 1 min at 10,000 × g to elute the RNA. 

21. Repeat Steps G19 and G20 using another 30 μl RNase-free water. 

22. Store the eluted RNA in -20 °C. 
 

H. Spectrophotometric quantification and quality determination of RNA with NanoDrop 

1. Open the NanoDrop 1000 software. Select nucleic acid analysis and then RNA in the 

respectives tabs. 

2. Put 1 µl of the eluted RNA sample on the sample loading position. 

3. Measure the absorbance. 

Note: A260/A280 ratios of the purified aliquots above 1.9-2.1, indicate that the isolated total RNA is 

efficiently purified for further use. 

 

I. Reverse transcription of NNV RNA from fish samples 

1. Set up the reverse transcription reaction (20 µl) by mixing 5 µl of oligonucleotide dT20 (2.5 mM), 

1 µl of dNTPs (dNTPs: dATP, dTTP, dCTP, dGTP; 0.5 mM each), 100 ng of purified total RNA 

and the appropriate volume of RNase-free H2O up to 13 µl. 

2. Heat the mixture to 65 °C for 5 min, and quickly chill on ice (0 °C, 1 min). 

3. Collect the contents of the tube by centrifugation and add 4 µl of first-strand buffer (1×), 1 µl of 

dithiothreitol (0.1 M), 1 µl RNase OUT RNase inhibitor (40 U) and 1 µl of Superscript II reverse 
transcriptase (200 U). 

4. Incubate at 50 °C for 60 min. 

5. Inactivate at 70 °C for 15 min. 

6. Store the produced cDNA at -20 °C. 

Please cite this article as: Toubanaki and Karagouni, (2020). Paper Lateral Flow Biosensor for Nodavirus Reverse Transcribed RNA
Detection,Bio-protocol 10 (15): e3711. DOI: 10.21769/BioProtoc.3711.

http://www.bio-protocol.org/e3711


                 

Copyright © 2020 The Authors; exclusive licensee Bio-protocol LLC.  9 

www.bio-protocol.org/e3711     
Bio-protocol 10(15): e3711. 
DOI:10.21769/BioProtoc.3711

 
 

J. PCR of NNV cDNA 

1. Set up the PCR mastermix (18 µl) by mixing 4 µl of the DNA polymerase reaction buffer (1×), 

1.6 µl of MgCl2 (2 mM), 0.4 µl of dNTPs pool (200 µM each), 1 µl of the upstream and 

downstream primers (0.5 mM), 0.1 µl of GoTaq Flexi DNA polymerase (0.5 U) and ddH2O. 
2. Add 2 µl of cDNA to the PCR mastermix. 

3. Put samples in the thermal cycler, with the following cycling conditions: 95 °C for 5 min, followed 

by 35 cycles at 95 °C for 30 s, 60 °C for 60 s, and 72 °C for 60 s. 

4. Incubate the samples reactions at 72 °C for 7 min and cool down to 4 °C. 

5. Store the produced amplification products at -20 °C. 

Note: Include negative controls (containing PCR-grade water instead of DNA) in each series of 

PCRs to confirm the absence of contamination. 

6. Visualize the PCR products by 2% agarose gel electrophoresis. 
7. Quantify the PCR products by ImageJ software based on the φX174 DNA HaeIII digest DNA 

molecular weight marker. 

Note: All concentrations are the final concentration in 1× reaction. The procedure should be 

performed in DNA Workstation equipped with UV-Vis lamp to decontaminate reagents and 

equipment. 

 

K. Tailing of nodavirus-specific (probe_Ndv) oligonucleotide probes with dATP 
1. Dissolve the lyophilized probe_Ndv oligonucleotides with the proper amount of PCR-grade 

water for 100 pmol/µl stock solution preparation. 

2. Set up the tailing reaction (20 µl) by mixing 2 µl of the terminal transferase reaction buffer (see 

Step A2), in pH 7.9; 2 µl of CoCl2 (0.25 mM); 4 µl of dATP (2 mM); 0.5 µl of TdT (10 units) and 

4 µl of probe_Ndv (400 pmol). 

3. Incubate for 1 h at 37 °C. 

4. Stop the reaction with incubation at 70 °C for 10 min. 

5. Mix the probe_Ndv with 1.5 µl N-methylmaleimide (40 nmol/µl). 
6. Store the probe_Ndv tailed oligonucleotides at -20 °C. 

 

L. Lateral flow biosensor detection assay of NNV amplification products 

1. Mix a 5 µl aliquot of PCR products solution with 1 µl of NaCl 0.9 M, 0.5 pmol of dATP-tailed 

probe_Ndv and ddH2O, to final volume of 10 µl. 

2. Heat the mixture at 95 °C for 3 min and place on ice for 30 s. 

3. Incubate the mixture to 37 °C for 10 min to allow hybridization to proceed. 

4. Apply the hybridization mixture to the conjugation pad next to the poly(dT)-functionalized gold 
nanoparticles. 

5. Dip the immersion pad of the biosensor into 250 µl of the LFB developing solution. 

6. Wait for signal formation. The visual detection is completed within 20 min. 

7. Scan the LFBs with a desktop scanner and quantify the band densities with ImageJ software. 
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Data analysis 
 

A. Visual signal detection of lateral flow biosensor 

1. After signal formation is competed (~20 min) take the LFB off the developing buffer and dry it 
by swipping carefully with plain paper towel. 

2. Scan the LFB in a desktop scanner with the higher analysis settings and save it as .tiff files. 

3. Open the image with any image processing software (e.g., PhotoShop) and crop the LFB pads 

in a way that only the membrane is visible. The results are shown in Figure 2, where representive 

images of a positive and a negative nodavirus sample, after assay completion are depicted. 

 

 
Figure 2. Representative lateral flow biosensor images for visual detection of a positive 
and a negative nodavirus sample and side view of the lateral flow biosensor presenting 
its working principle. IP: immersion pad; CP: conjugation pad; M: diagnostic membrane; AP: 

absorbent pad. (CZ: control zone; TZ: test zone). The assay components are not in scale. 

 

B. Semi-quantitative estimation of LFB signal by ImageJ 

1. Open your image with ImageJ. Then you can greyscale them with ImageJ. 
2. Go to Image → Type and click on 8-bit to convert the image to grayscale. 

3. Go to Process → Subtract Background and set rolling ball radius on 50. 

4. Go to Analyze → Set Measurements and click the boxes for Area, Mean Gray Value and 

Integrated Density. 

5. Go to Analyze → Set Scale and enter ‘pixels’ for Unit of length. 

6. Choose the Rectangular Selection tool and draw a rectangle around the mambrane. 

7. Press 1 and a window will pop up with the image and a blue label around the rectangular 

selection. 
8. Move the rectangle over the next LFB and press 2. Repeat for each LFB. 

9. When finished, press 3 and a new window with a profile plot of each membrane will pop-up. 
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10. Choose the Straight Line selection tool. At the base of each peak, draw a line from one side of 

the peak to the other, enclosing the peak area. 

11. When each peak has been closed off choose the Magic Wand tool. 

12. With the wand, click inside each peak. 
13. The numerical results will pop up in a result window. 

14. Transfer the results to Excel workbook and draw the desired graph, e.g., results section on 

Toubanaki et al., 2015. 

 

Notes 
 

1. Procedures A, C, D, G, I, J and K should be performed in DNA Workstation equipped with UV-

Vis lamp to decontaminate reagents and equipment. 
2. All concentrations refer to the final concentration in 1× reaction. 

 

Recipes 
 

1. Phosphate-buffered saline, 10× (PBS, pH 7.4) 

a. Dissolve 80 g NaCl, 2 g KCl, 11.5 g Na2HPO4 and 2 g KH2PO4 to 800 ml distilled water 

b. Adjust pH to 7.2 with 1 M HCl or 1 M NaOH depending on the acquired pH and bring volume 
to 1 L with distilled water 

c. Filter sterilize with 0.22 μm filter 

d. Store at 4 °C 

e. Dissolve 100 μl of stock solution (10×) in 1,000 ml of de-ionized water for the working 

solution of PBS (1×), when needed 

2. LFB developing solution 

a. Dissolve 4 ml glycerol and 1 g/L of SDS in 100 ml 1× PBS 

b. Store at 4 °C 
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